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All the contents of PCLinuxOS Magazine
(pclosmag.com) are only for general information
and/or use. Such contents do not constitute
advice and should not be relied upon in making
or refraining from making any decision. Any
specific advice or replies to queries in any part
of the magazine is the personal opinion of the
contributers and are not subscribed to by
PCLinuxOS Magazine.
The information in PCLinux Magazine is
provided on an “AS IS” basis, and all warranties,
expressed or implied of any kind, regarding any
matter pertaining to any information, advice or
replies are disclaimed and excluded.
PCLinuxOS Magazine and its associates shall
not be liable, at any time for damages (including
without limitation, damages from loss of any
kind) arising in contract, tort, or otherwise from
the use of or inability to use the magazine or any
of its contents, or any of its contents, or from any
action taken or not taken as a result of using the
magazine or any contents or for any failure of
performance, error, ommission, interruption,
deletion, defect, delay in operation or
transmission, computer virus, communications
line failure, theft or distruction or unauthorized
access to, asteration of, or use of information
contained in the magazine.
No representations, warranties, or guarantees
whatsoever are made as to the accuracy,
adequacy, reliability, completeness, suitability,
or applicability of the information to a particular
situation.
Certain links on the magazine lead to resources
located on servers maintained by third parties
over whom PCLinuxOS Magazine has no
control. By visiting these, you are doing so of
your own accord and assume all responsibility
for such action.
These terms constitute the entire agreement
between the parties with respect to the subject
matter hereof and supercedes and replaces all
prior or contemporaneous understandings or
agreements, written or oral, regarding such
subject matter.
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GUG Chapter 3
Using the Desktop
The Desktop provides a useful
metaphor for a modern office/home
work environment. On the Desktop
we find that the applications that we
want to run can easily be started or
launched and the information and data
that we need can easily be located.

click once on the icon representing the application.
To run an application from the Desktop itself, click once on the icon representing
the application.
Sometimes it is handier to have an application as an icon on the Panel or Desktop
where you can launch it more easily by just clicking on it, rather than in the
Applications Menu, especially if it is buried deep within several sub-menus. To
achieve this, open the Applications Menu and select the application item by
clicking with the right mouse button. Click on the "Add this launcher to panel" and
a copy of the application icon will be placed on the Panel.

Running Applications
Applications that we can run from the
Desktop are found either from the
Applications Menu (and sub-menus
therein), or, as icons on the Panel and
the Desktop itself.
To run an application from the
Applications Menu, open up the menu
(or sub-menu) and click on the
application listed in the menu bar.
To run an application from the Panel,
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To make a link of the application on the Desktop, click with the right mouse button,
and select "Add this launcher to desktop" and the application icon will be placed on
the the Desktop.
To remove an application icon from the Panel, right-click on it and select the
"Remove From Panel" option.
To remove an application icon from the Desktop, right-click on it and select the
"Move to Trash" option.

The Panel
The Panel houses many useful utilities called applets. Applets are small
applications that run on the Panel. As discussed in Chapter One, by default, the
October 2008

Taskbar and the workspace switcher
applets are placed in and run on the
bottom Panel. Other useful applets
that are placed on the top Panel
include:

clock
network status icon
volume control
preferred applications (Firefox,
Thunderbird, Glipper, and a terminal)

Placing an Applet on the Panel
To place an applet on the Panel, move
the mouse over to an empty space on
the Panel and right-click it. Select the
item "Add to Panel" and from the submenu select the applet to place on the
Panel. For example, to place the
"Battery Charge Monitor" applet on the
Panel, select:

Monitor -->Add
To prevent accidental removal of an
applet, you can lock the applet by rightclicking on it and selecting "Lock To
Panel."

Removing an Applet from the
Panel
To remove an applet, right-click on the
applet icon and select the "Remove From
Panel" option. If the applet is locked, you
will have to unlock it first by right-clicking
on the icon and clicking on "Lock To
Panel."

Configuring the Panel
To change the properties of the Panel, right-click on the Panel
and select "Properties."
From the General properties tab you can change the position,
length, whether to hide it or not, and size of the Panel.

Add to Panel --> Battery Charge
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From the
Background
properties tab,
you can change
the background
of the panel to
match the
current theme,
to a solid color,
or match your
Desktop
background.

To create a launcher on the Desktop, right-click on an empty area on the Desktop
and select the item "Create New." From the sub-menu, select "Link to Application".
Enter the Name and the Command to run (in the box seen below) and if you want,
you can select an icon for it by clicking on the icon button.
You can find most of the
commands you need by
clicking on the "Browse..."
button, use the "up" arrow
to move up in the file
structure to "/" and doubleclick on "/usr." Once that
window opens you can
double-click on either
"/bin" or "/share" and
choose the necessary
command in most cases.

Launchers
Launchers allow the user a quick way
to access specific resources on the
system. For example, if a user often
needs to access a specific file in one
of the folders, he/she can create a
launcher to run an application to open
the file and this launcher can be
placed on the Desktop. In this way the
resource (the file) can be accessed
very quickly by just double-clicking on
it.
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Exercises
The Gimp image manipulation program is a popular application for Linux systems.
Locate the Gimp application in the Applications Menu and place it on the Panel as
well as the Desktop. Launch the Gimp application from:
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the Desktop
the Applications
Menu the Panel
Configure the Panel so that it has the
following properties:
a background color of solid
bluecontains the Battery Charge
Monitor and Force Quit (locked)
applets
Create a launcher to run the text editor
command "GEdit" on the Desktop. Use
an appropriate icon for the text editor.

Setting the Date and Time
It is important that the date and time
are set correctly in your system. This
will make it easier to manage the
system resources and files, and also
aid in troubleshooting any problems.
To set the date and time, run the Date
& Time application tool from the
PCLinuxOS Control Center:
7
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System --> Administration --> Configure Your Computer --> System --> Adjust the
date and the time
A dialog box asking for the root
password will appear if you are not
logged in as root. This is because
the system date and time are
important system parameters and
so only the system administrator, or
root, is allowed to change it. After
entering the correct root password,
you can change the date using the
displayed calender, and the time in
the boxes provided. Select the
Time Zone tab and check to see
that the timezone selected is
correct. If not, correct it by selecting
the appropriate timezone region.
Click on the OK button after all is done to enable the new date and time. You can
check for the new date and time by looking at the clock (time) applet display on the
Panel at the top of the screen. If the time is correct, click on the OK button.
So ends another chapter on learning and using our Gnome desktop. I will bring you
some more interesting information next month as we continue on this journey. See
you then!
October 2008

I have used MS Windows for 13+
years.
That's right, Windows 95 came out in
1995, of course, and I was using
Windows way before Windows 95.
I spent $1800.00 and built the
computer of my dreams. I loved it.
Man, it ran great. But alas, they broke
into my house, and when I walked in
after work, the first thing I noticed was
that my computer was gone. Yup, they
stole it, my beautiful piece of
machinery. I've been online for 13 plus
years, and I don't seem to function
right without a computer and the
internet. So, I bought a Dell Optiplex
GX110 at a yard sale for 20 dollars.
This thing sucks, 384M of ram, and the
on-board video was SOOOO weak, I
installed the only thing I knew to install,
Windows XP. My poor, timid, 8Gb hard
drive was half gone after an install,
needless to say it ran like tee total
crap. Yeah, it was fairly stable, as
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stable as it has always been, but just
booting my computer consisted of
hitting the power button, and keeping
busy for 6-7 minutes. I couldn't take it
any more; I needed a solution. I spent
more time waiting for my PC to do
something than actually using it. I
erased XP and installed, per the
'designed for' sticker on the front of my
new PC, Windows 98, only to find out
that every 3 out of 4 programs that I
was used to running, didn't work, didn't
offer an alternative and, above all else,
did not have a half decent replacement.
If you can install 98, then try to get a
firewall, antivirus, and spyware
remover, and succeed, you are indeed
a tech genius. I could not even find
adequate programs to ensure a secure
system.

I don't remember my exact words
when doing a search that brought me
to an article about PCLinuxOS. Sure, I
had heard of Linux before, but many
brief experiences with it proved much
too complicated for me. However,
there was something about the
screenshots and the articles I read that
for whatever reason, for the first time
in my life, I downloaded a version of
Linux.

Again, I needed a solution.

I downloaded, burned and installed
PCLinuxOS effortlessly, and I have
used it for over three weeks. I switched
2007 to MiniMe 8 days ago, and I can
not express the ease of installation,
use, configuration and sheer

My old machine couldn't compete with
today's software, so I searched.

I have used MS Windows for 13+
years.
WOW
I really mean it, WOW
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enjoyment that I have felt since
discovering what many in this world
have known for many years.........
Linux really is a good operating
system, and PCLinuxOS is, among
what I have learned, one of many
"types" of Linux. It is one “kick butt”
OS! I have been misled for many
years; there are not also other
operating systems, there are in fact,
BETTER operating systems.
PC Linux OS 2008 "MiniMe" is the
greatest thing I have ever installed on
my computer. Although there are
many types of Linux, I know that had I
not tried 2007 first, I would never have
stayed. I have a fully functional, highly
capable, extremely smooth-running
machine, that not only does everything
I want it to do, it does it well, and
super-fast. After the install of MiniMe, I
am, for the first time ever, building my
OS from the ground up, the way I
WANT IT, not the way your company,
ahem, MS, says it should be.
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I haven't rebooted in days; my OS has
NEVER crashed or froze; the
configuration and customization is
utterly endless.
What can I say except YOU GUYS
ROCK!
I am on websites learning how to use
consoles, learn Linux commands and
understand the file structure. I am
convinced, I am not erasing my
MiniMe. I'm converted, I'm here to stay,
As a final note, on this extremely longwinded testimony, I needed space in
my CD holder to hold my 2007 Full and
2008 MiniMe CD's........ so I threw
away my burned copy of Microsoft
Windows XP Professional!
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VirtualBox Easier Than You Think
VirtualBox Easier
Than You Think!

By Paul Arnote
I had been looking at VirtualBox (in the
PCLinuxOS repositories) with great
interest for quite a while. However, I
was somewhat intimidated about
giving it a try, due to all the reports
from folks in the forums who reported
some difficulties in getting it properly
set up, coupled with how difficult the
directions seemed. Boy, was I wrong
on both accounts!
I run one of my many laptops as a dual
boot system, dual-booting PCLinuxOS
and Windows XP. Yet, the longer I use
PCLinuxOS, I find myself logging in to
Windows XP less and less frequently.
Currently, I only log into Windows XP
to 1) do the required periodic updates,
and 2) to do some occasional photo
editing. (I'm not fully comfortable with
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GIMP or any other Linux graphics editing package ... but I'm working on it!)
So I finally decided to "take the dive" and give VirtualBox a try. The following is a
step-by-step method of how I was able to get VirtualBox up and running with a full
installation of Windows XP. This should work relatively well with Windows 98,
Windows ME, Windows 2000, or possibly even Vista.

STEP ONE:
You will need the following items:
A Windows XP installation CD (or other version of Windows; this guide is centered
around Windows XP, but should be similar to other Windows versions.)
The nLite application from the Web (freeware download)
Windows XP SP3 (if using Windows XP and a free download from the Windows web
site. Download and save to your computer. Look for the file for IT/Network
Professionals.)
A blank CD-R (or DVD-R) and CD-Burning software (K3B works well) [Optional]

STEP TWO:
From within Windows XP, install nLite.
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STEP THREE:
Insert your Windows XP installation
disk. Allow nLite to copy the CD
contents to your hard drive. You will
also need your Windows XP Product
Key later on, so be sure to have that
handy.

install disk. “Slipstreaming” the latest
service pack into your installation will
prevent you from having to spend
your time downloading it again, and
you will create an installation disk
with the latest version of Windows on
it. Also, you will only need the latest
service pack (SP3), since it contains
all the updates that were included in
the previous service packs.

STEP FIVE:

STEP FOUR:
Select ALL the options, including
"Slipstreaming" your Windows XP
installation to include the Windows XP
Service Pack 3 update in your nLite
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Now, sit back and wait while nLite
performs the slipstreaming
procedure, and while Windows
updates your “Windows Share,”
integrating the SP3 update into
your Windows installation folder.

October 2008

STEP SIX:
Unless you have them downloaded as
EXE files, you can skip by the next
step of including Hotfixes, Add-ons,
and Update Packs by hitting NEXT.

STEP EIGHT:

STEP SEVEN:
Locate your drivers and add them from
your Windows installation. Usually,
selecting Multiple Driver folder will load
all your drivers in. Select ALL, then
OK, then NEXT.
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In the Compatibility dialog, select the
components you want to prevent being removed
accidentally.

STEP NINE:
Select components to remove but DO NOT
include your new Windows installation CD. You
can be somewhat ruthless here. For me, this
October 2008

was rather easy. Things I never use,
such as Bluetooth connectivity, and
WordPad, I chose to leave out. You
may also want to leave out the games
and any other programs that you don't
routinely use while working in
Windows. The more you leave out, the
smaller your installation files will be,
the faster Windows may run, and the
less room it will take in your VirtualBox
installation. Just be careful when it
comes to system services, since
exclusion of some items will break
certain features of Windows XP.
Fortunately, nLite is pretty good at
letting you know which features may
be broken should you choose to leave
out or disable features. Just tread
cautiously here, but be honest and
ruthless.

STEP TEN:
Set the Unattended Installation
options. Here is where you will need
your Windows XP CD Key, User
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names, passwords, etc. Be sure to
check for options you want on ALL
the tabs. Taking your time here will
save you the hassle of having to
enter all sorts of things during the
Windows XP installation on your
future virtual machine, and having to
sit there and wait to be prompted to
enter each and every little thing.

STEP ELEVEN:
Set Tweaks for your new Windows
installation. Windows has all kinds of
hidden tweaks and settings, and
nLite allows you to make many of
them so they are set up from the
start. Some of the various "hidden"
settings in Windows XP include
Windows Explorer behavior, viewing
of hidden or system files, viewing of
file extensions, etc. Spend the time
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at this point to carefully select your
options to minimize the
"customization" you will have to do
when you install Windows XP into
VirtualBox. You can leave the items in
the Services tab as they are (set to
Default). Click on NEXT.

STEP TWELVE:
Now sit back and wait while nLite
processes all the changes you have
made to your Windows installation.
Depending on the speed of your
processor, this may take a little while.

STEP THIRTEEN:
Now it's time to make the ISO file of
your new Windows XP installation!
You're almost there! This process,
like the last one, may take a little
while, so go grab a snack from the
fridge or a glass of cold iced-tea.

STEP FOURTEEN (Optional):
Reboot your computer into PCLinuxOS
and burn a copy of your ISO to a CD (or
DVD if your ISO file size exceeds the
capacity of a CD-R). K3B works
exceptionally well for this. This step is
listed as optional, since VirtualBox can
install directly from an ISO. However, I
wanted to save a copy for future use,
should I decide to repeat this at a later
date, saving me from having to repeat the
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process spent making the ISO file in
nLite.

STEP SIXTEEN:
When you select a NEW virtual
machine, you will be greeted with the
“Welcome to the New Virtual Machine
Wizard” window. Click on NEXT.

STEP FIFTEEN:

STEP SEVENTEEN:

Install a copy of VirtualBox from the
PCLinuxOS repositories. It is also a
good idea, at this time, to go ahead
and install the VirtualBox Guest
Additions as well. Start VirtualBox and
select a NEW virtual machine.

Now you are greeted with the VM
Name and OS Type window. Give
your guest OS a recognizable name,
and specify the type of OS it is. In
my case, I named it WinXP-SP3,
and selected Windows XP as the
OS type.

STEP EIGHTEEN:
Now you'll be asked how much of your computer memory you want to devote to
running the guest OS. In my case, I chose only 192 MB. Windows XP will run OK
15 :: PCLOS Magazine
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with even less. One reason I chose
only 192 MB (besides it being what
was recommended by VirtualBox), is
that this particular computer only has
512 MB of total memory installed. My
other laptop, which also has a copy of
Windows XP running in VirtualBox,
has 512 MB of memory assigned to
running the guest OS, since that
computer has 1 GB of memory
installed.

the guest OS in your virtual machine.
Since you have not yet created any
virtual machines, you will not have any
virtual hard drives set up. So you need
to select NEW at the bottom of the
window.

STEP TWENTY:
This will bring up the Create Virtual
Disk Wizard. First, click on Next, then
select Dynamically Expanding Image.

Selecting the “Dynamically Expanding
Image” ensures that the virtual machine
will only use as much hard drive space as

STEP NINETEEN:
Now is where you specify how much
of your hard drive you want to assign
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is necessary, and will allow it to “grow”
up to the specified size on an “asneeded” basis.
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STEP TWENTY-ONE:

Hard Drive. Click on NEXT.

STEP TWENTY-THREE:

Now you need to set the size of the
virtual hard drive you want to allocate
to the guest OS. I chose only 10 GB,
the minimum recommended size,
since I rarely have a need to use
Windows these days and prefer to
stick with PCLinuxOS for most of my
computing needs.

You are now returned to the Virtual Hard
Disk window. Select the new virtual hard
disk you just created, and click on NEXT.

STEP TWENTY-FOUR:
Now you will see the Virtual Machine
Summary. Select the FINISH button to
proceed.

STEP TWENTY-TWO:
You will now see a summary of the
previous few steps to set up the Virtual
17 :: PCLOS Magazine
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onCD/DVD-ROM and you can tell VirtualBox
to either boot from the ISO file you created
with nLite, or from the CD/DVD you burned
from your ISO file. In my case, I chose to
simply boot from the ISO file, and pointed
VirtualBox to it's location.

STEP TWENTY-FIVE:
Once that is all done, your new virtual
machine will be listed in the VirtualBox
OSE main window.

At this point you might want to make any
other changes in the different categories listed
on the left. This includes enabling audio in
your guest OS by setting it to be parsed by
the Linux ALSA driver.

STEP TWENTY-SEVEN:

STEP TWENTY-SIX:
Now it's time to install your guest OS
(in this case, Windows XP) into your
newly created virtual machine. To
start, you will need to tell VirtualBox
where to find the guest OS. Click
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Now it's time to start your new virtual
machine. When you do, the ISO (or
CD/DVD) will boot and your guest OS
will be installed. It's time to take another
short break while Windows XP installs.
Typically, this takes about 40 minutes or
so.
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STEP TWENTY-EIGHT:

STEP TWENTY-NINE:

When Windows XP has finished
installing, you will have a fully capable
installation of Windows XP running in
a window on PCLinuxOS! However,
you are NOT finished yet. At the top of
the Windows XP window, you need to
click on the “Devices” menu and select
“Install Guest Additions.”

You need to now close your Windows XP
window, and return to the VirtualBox OSE
main window. We need to change the
CD/DVD-ROM from the ISO file to the
computer's built-in CD/DVD drive. To do this,
simply click on CD/DVD-ROM and make the
change in the settings window. Note that this
is ONLY possible when the virtual machine is
NOT running, and the heading is BLUE in
color.

STEP THIRTY:
This might also be a good time to (optionally)
set up any folders on your host computer that
you want to share with the guest OS. Doing
so, will give your guest OS access to files on
the host computer. In the “Details” tab of the
VirtualBox OSE window, scroll down to
“Shared Folders” and add the folders you
would like to have access to while working in
your guest OS in a virtual machine.
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STEP THIRTY-ONE:
You will be faced with a few additional
updates to your Windows XP
installation. Now is as good of a time
as any to go ahead and allow them to
complete. Windows XP will use the
PCLinuxOS wireless or ethernet
connection to connect to the Internet
to complete this task.

SUMMARY:
Now you are running Windows XP in a
virtual machine in PCLinuxOS!
Imagine ... Windows XP in a
PCLinuxOS window! From within your
VirtualBox installation of Windows XP,
you can install any programs you want
to have available from within Windows
XP.
I have to say, Windows XP literally
FLIES inside VirtualBox! My previous
installation of Windows never ran so
good when it was natively installed on

20 :: PCLOS Magazine

my hard drive. My Windows XP startup, which typically used to take from 1 minute,
30 seconds to a full two minutes, now takes LESS than 45 seconds to boot. And it's
very fast and responsive, almost as if it were created especially for VirtualBox.
Another nice attraction is that I can choose to run Windows XP within a virtual
machine window on top of PCLinuxOS, or I can choose to run Windows XP full
screen by pressing the Right CTRL key in combination with the 'F' key. A simple
toggle of that key combination allows me to switch back and forth, at will, between a
full screen display and a windowed display of Windows XP.

Had I known it was this easy to set up VirtualBox, I'd have done it a LONG time ago!
Now, with the success I've had in setting up Windows XP running in VirtualBox, I'm
very seriously considering the removal of my Windows XP partition from my hard
drive and reclaiming it's use for PCLinuxOS! Who couldn't use another 50 GB of
hard drive space (the amount I have reserved for Windows XP in my dual boot
configuration)!
I have done this on two of my laptops running PCLinuxOS! It's literally THAT easy to
do! So if you've ever thought about running or using VirtualBox, don't shy away!
Plus, the added benefit (providing you have the hard drive space to allow it), you can
also run or try out other Linux distro's in VirtualBox, running straight from the
downloaded LiveCD ISO files!
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If you would like some more
information, you can check out the
following internet links:
VirtualBox:
http://www.virtualbox.org
LifeHacker:
http://lifehacker.com/386526/slipstream
-service-pack-3-into-your-windows-xpinstallation-cd
The VirtualBox links will give you
access to the documentation files for
VirtualBox. The LifeHacker link will
give you some good information on
using nLite to create your
“slipstreamed” Windows XP
installation disk.
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Computer Languages: BASIC
Gary L. Ratliff Sr.
<eronstuc@gmail.com>

An Alphabet of Computer
Languages: BASIC
When people first purchased their new
computers in the early years of
personal computers, one of the things
they could be most sure of was that
the computer would come with the
Basic language installed. The
Commodore PET came with a version
from Microsoft as did the Apple and
the TRS 80. However, each computer
sported a slightly different version of
the language. There were so many
dialects of Basic that soon David A.
Lien wrote A Handbook of Basic
which defined all the keywords for the
many dialects.
The repositories for PCLINUXOS have
three separate versions of Basic which
this article will discuss: REALbasic,
Basic256, and Gambas. Each of these
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may be obtained by using the Synaptic Package Manager. One opens the program
and locates these items by doing a search for “basic.” The list is so long because
any package which has “basic” in its description will be included in the search results.

REALbasic
The use of this language was the subject of my article in the February 2008 issue of
this magazine. You may find the article from this link:
http://pclosmag.com/html/Issues/200802/page05.html
I mentioned that the language is being actively developed and that there is a new
release every three months. For this reason, one may wish to obtain the language
from the Real Software site itself. The instructions for obtaining, installing and using
the product are in the article and will not be repeated. This is a wonderful product
and it seems to be free for the Linux community. The programs developed for my
Windows system only worked for a period of 30 days. However, the programs
developed for the Linux system are still functional. Also, there is video support for
speeding your learning process with this system.

BASIC256
This program was originally named Kidbasic and was inspired after the creator read
the article “Why Johnny can't code.” This article remarks that while the older
October 2008

generation grew up with a computer
which came with Basic installed, this is
not currently true. This language was
developed so that one may teach
children how to program using a
simple line-oriented language.
To install it to your system just open
the Synaptic Package Manager and
give the root password. Search for
“Basic” as previously mentioned. Find
the file named basic256 from the list
offered and mark it for installation.
Note that this will also install several
other programs which the system
depends upon to function. Your results
will most likely vary but my system
installed a total of 11 packages to get
a working basic256 system.
To open your new system, go to the
menu and select: More Applications ->
Development ->Development
Environments -> BASIC256. You will
be presented with a new program IDE.
In the text window you will type in the
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familiar Basic commands and when the Run command is clicked your program will
execute in either the text or graphics display area. If instead of clicking the run
command you select debug, then an item allowing you to step through the program
one line at a time will be offered.
Once you have the system installed, you are ready to learn to use your new system.
By clicking the About menu item you will learn that you may find tutorials and
documentation for the system at:
http://kidbasic.sourceforge.net/
The website will contain menus for the tutorials, the documentation, and an article
which shows how the Basic computer language is still useful for teaching new
computer users, specifically children, about the functions of a computer. In the
documentation section you will receive a list of the correct syntax for using all the
commands of the language. As this material is only seven printed pages it might be
best to just make a printed handbook of this information. That way it is available for
use as you begin to create example programs to run.
You will notice that this system is free under the GPL. It is also available in a version
for Windows. This comes as a zipped file and should be extracted to its own
directory. Then one gets it to run issuing a basic256.exe command.
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The repositories for PCLINUXOS have two separate sets of Gambas programs.
There is a set for the first version of Gambas and another set for Gambas2. I
installed the Gambas2 set on one of my computers, Eronstuc, and the original
version of Gambas was installed on another machine, Gabriel. Because either
version has a tremendous set of dependencies which must be satisfied, use the
Synaptic Package Manager for your install of either system.

Here is the development screen for
BASIC256. The text of the Basic
program is entered into the Window.
Any text output will appear in the Text
Window, while commands which
produce graphical output will appear in
the Graphics Window.
The Run arrow will run the entire
program. The Debug item will allow
the program to be run one step at a
time.

GAMBAS (Gambas Almost
Means Basic)
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Once you call upon the package manager you will be asked for the root password.
Now do a search for “Gambas.” You will note that a tremendous number of
applications will appear. These will be divided into camps; one will start Gambas,
and the other Gambas2. As either
system supports several features,
select all items from either set. This
will involve about fifteen to twenty of
the Gambas or Gambas2 items being
selected. Then select Apply and let
the
system
install
the
Gambas items.
For an introduction to some of the abilities of the
system you will need to launch your new system. To
do this go to the main menu and select: More
Applications -> Development -> Development
Environments -> Gambas or Gambas II. You will be
presented with the opening screen for the particular
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version you have installed.
By exploring the recent projects area
you will be able to launch several
example applications to watch the
Gambas system running. Each of
these applications will be read only so
that they may not be altered. Here pay
attention to the fact that each will have
several classes and other structures
which will make up the system.
To learn how to use this system, run a
search for “Gambas” in Google. You
may wish to learn the many features
offered by the system from the wiki
articles on the language. However, the
best source for learning to use this
system is the pdf file: A Beginners
Guide to Gambas. This is a 365 page
book which will guide you step by step
through the process of learning how to
program using the Gambas language.
The examples should be followed in
order as the material builds
systematically on what has been
learned before.
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I am making a video which will be available in the “videos by eronstuc” area of You
Tube. This will be called “Gambas Setup”. At the moment people are being rushed
out of their homes and apartments to avoid being in the path of Gustav, so this
article is being cut short. There is much to learn and once you master the material
you will have a very powerful tool for developing either GUI or text applications.
Also, if you used one of the early computers of the 80's you will most likely
recognize the true BASIC heritage of the Gambas system.
This shows the path through the main menu to launch your Gambas application.
Here we see some of the many Example applications which may be launched to
show just some of the power of
the Gambas system. This is the
set from the second version of
Gambas.
Again the very best source for
learning to use this system is the
book:
Gambas for Beginners.

Editor's Note – This was inadvertently left out last month I apologize for any
inconvenience it may have caused.
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This guide has been modified by Papawoob to reflect the Linux distribution of
PCLinuxOS 2007.

Multimedia Access and Players
Apart from being able to view and create graphics and other images, the PC is
capable of supporting a wide range of audio and video features and facilities. These
include the playing of audio CDs, audio digital files, VCD and DVD as well as
multimedia games.
Note:
While support may be available in the software, the necessary hardware has to be
available before these multimedia facilities can be used, e.g. a DVD drive is required
to be present on the system before you can play a DVD.
By default most modern PCs come with a CD-ROM drive capable of playing audio
CDs and VCDs as well as a sound card and speakers. As such in this chapter we
shall discuss how you can listen to an audio CD, play audio digital files and view
VCDs.
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In the following sections we shall be
discussing several media players.
Some of these e.g. mplayer and xine
are multimedia players in that they can
be used as generic players for audio
CD, digital audio files, VCD and DVD.
The Volume Control Applet
Since almost all the multimedia
applications require some form of
audio production and mixing, it is
useful if we know how to control the
various channels of audio available
from the sound card using the Volume
Control Applet on the Panel. This may
be launched by right-clicking the
Volume Control icon on the Panel and
selecting Open Volume Control. If it is
not there you can also launch it form
the Main Menu:

KMix is essentially an audio mixer
which enables you to mix the audio for
a 2-channel sound card. Every mixer
control that your sound card provides
is represented by a volume slider.
Mono controls always have a single
slider while stereo controls can have
either one or two sliders, depending on
your settings. There is also a panning
slider at the bottom of the window. If
your system has more than one sound
card, a list will be displayed at the top
of the window.
The KMix window can have up to three different sections, Output, Input, and
Switches. Each section will contain volume sliders, switches for enabling/disabling
record or playback functions, and multiple choice selectors.
Output: This tab holds the controls that are most likely related to playback, like the
Master volume control.
Input: This tab holds the controls that are most likely record related, like Capture.

Main Menu -> Multimedia -> KMix
Switches: These controls allow you to switch certain functions On and Off, like
External Amplifier.
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KMix also features LEDs. The general
coloring rule is as follows:
Green: An LED dealing with playback
Red: An LED dealing with recording
Yellow: An LED dealing with special
sound card capabilities
A lit LED means On, a non-lit LED
means OFF.
In most situations the volume can be
adjusted by clicking on the Volume
Control applet on the Panel and
raising or lowering the slider
accordingly.

Playing Audio CDs
You can play an audio CD by placing
the CD into the CD-ROM drive. The
CD player application (KsCD) will be
run automatically to play the CD.
Ensure that your speakers are turned
on so that you can hear the CD! You
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can also manually start the CD Player application from the Main Menu:
Main Menu -> Multimedia -> Sound -> KsCD
You can control the CD Player just like a normal CD player with the buttons shown
on the CD Player screen.
These include volume
control, track
forward/backward,
play/pause, stop, eject as
well as jumping to any track
on the CD directly.

Playing Digital Audio Files
PCLinuxOS gives us Amarok which is arguably the most complete music manager
available today. Amarok serves many functions rather than just playing music files.
For example, Amarok can be used to organize a library of music into folders
according to genre, artist, and album, can edit tags attached to most music formats,
associate album art, attach lyrics, and automatically "score" music as you play it.
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Note: To work with Creative Zens or other MTP devices, libmtp0 will need to be
installed from the repositories.
One last notable feature is Last.fm support, including submitting played tracks
(including those played on some digital music players) to Last.fm, retrieving similar
artists, and playing Last.fm streams.
You can find Amarok by going to:
Main Menu -> Multimedia -> Sound -> Amarok
Amarok plays media files in various
formats including but not limited to
(depending on the setup), Flac, Ogg,
Mp3, AAC, WAV, WMV, and
Musepack.
Note: Amarok will not play digital
music files protected by DRM, such as
those purchased from the Itunes Music
Store.
It also can Sync, retrieve, play, and
upload music to digital music players,
such as Ipods or Creative Zens.
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Another excellent player that in the repositories and can be easily installed is XMMS.
The XMMS (X Multimedia System) application can be utilized to play a wide variety
of digital audio file formats. These include the popular MP3 as well as the open Ogg
Vorbis formats. To launch XMMS, (after it is installed) select:
Main Menu -> Multimedia -> Sound -> XMMS
Note:

i
i

XMMS may need additional plug-ins to
be able to play some of the audio file
formats. If these are not already
nstalled on your system they can be
nstalled from the repositories using
Synaptic.
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You can control the XMMS player
using the graphical knobs and buttons
displayed. In addition, you can select
the source of the audio files to play. To
do this, right-click on the XMMS player
and from the pop-up menu select "Play
File" to select the audio file to play. If
you want to be able to play an audio
file from the Internet select "Play
Location" and enter the Internet
location of the file.

Kaffeine from the Main Menu:
Main Menu --> Multimedia --> Video -> Kaffeine
The Kaffeine user interface is highly intuitive as it resembles a normal VCD/DVD
player with all the basic control knobs and buttons.
To play a VCD, place the VCD into the
CD-ROM drive and click on the Play
VCD button on the Kaffeine control
panel.

Playing VCD and DVD

To play a DVD, place the DVD into the
DVD drive and your movie should start
playing. If it does not then right click on
the DVD icon on your desktop and
choose "Play DVD with Kaffeine."

There are several excellent
applications readily available for you to
use to play VCD and DVD media.
Here we shall look at two of them:
Kaffeine and Mplayer. These can also
play CD and digital audio music files.

Kaffeine

The volume control can be adjusted by
clicking on the volume control button.

The Kaffeine application may be used
to play VCD and DVD. You can start

Kaffeine is a very powerful multimedia application with many features. It can also
play audio CDs as well as digital audio files.
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Note: to be able to play encrypted
DVDs you will need to install libdvdcss
and win32codecs from the repositories
using Synaptic. You will need to check
to see if the use of these libraries is
legal as it is considered illegal to use
this in certain parts of the world.

screens are displayed.

MPlayer
Mplayer is a popular movie player for
Linux. In addition to being able to play
VCD and DVD it is also able to handle
a wide variety of audio and video file
and streaming data formats. Hence it
is useful to use Mplayer as the
universal multimedia player. The
Mplayer GUI can be started from the
Main Menu,
Main Menu -> Multimedia -> Video >MPlayer
On start up, the main Mplayer control
screen and the Mplayer video output
31 :: PCLOS Magazine

The control screen enables you to
control the operations of Mplayer while
the video screen displays any video
that is being played. In addition, rightclicking with the mouse when it is
nside either the control or video
screens will also bring up a menu for controlling the use of Mplayer.

i

The Mplayer control screen enables you to perform the following:
start, stop and pause play
go to the next and previous stream
jump to the first and last tracks
adjust the sound balance
adjust the volume and mute
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select files to play
set up a playlist
set the video and audio equalizer
configure preferences
exit the Mplayer application
All of the above functions are
represented by intuitive knob, dial, and
button icons on the control screen
making it very easy to use Mplayer.
To play a VCD, place the VCD in the
CD-ROM drive, move the mouse over
the control screen or video screen and
right-click it. Select, VCD -> Open disk
To play a DVD, perform the above for
VCD but instead select,
DVD -> Open disk
The size of the video screen can be
controlled by right-clicking on the
mouse and selecting normal size,
double size or full screen. When you
are in the full screen mode, to return to
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normal size, right-click on the mouse and select normal size.

Exercises
Play an audio CD using the KsCD Player
Play an audio digital music using Amarok
Play a VCD or DVD using Kaffeine and MPlayer

Graphic Images Access
Very often it is useful if we are able to view graphic image files on their own, or in
thumbnail fashion if there are many of them. It is also useful if there are simple tools
available which will enable us to manage these image files, e.g. catalog and classify
them and recall them for viewing. In this section, we shall look at several tools
available on your system which provide some of these functionalities.

File Manager
The File Manager itself provides a simple and convenient means to access and view
image files. To view an image file from the File Manager, move your mouse pointer
over the file and a larger thumbnail picture will appear. To view the file full size
double click on it. Another convenient way of viewing when you have a lot of files in
a folder is to select the "View Mode > Photobook" option from the View menu
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selection.

Fig. Photobook View in File Manager
This will result in only the image files
present in the folder being displayed.
You can then select an individual
image to view and also perform zoom
in or zoom out views.

DigiKam Camera Access
Digikam is a simple digital photo
management application, which makes
importing and organizing digital photos
a "snap". The photos can be organized
in "albums" which are automatically
sorted chronologically. An easy to use
interface is provided to connect to your
camera and preview images and
download and/or delete them.

system as an album library, meaning that every sub folder of this folder will be
considered as a photo album and displayed in the album list on the left side of the
main window.
Clicking on an album will start showing the thumbnails for the images in the album.
You can change the icon size to small, medium, large or huge from the magnify
buttons in the toolbar. Right Clicking on an item will give you a pop up menu, using
which you can view, rename, delete, see the exif information, and add/edit
comments of the images. Double clicking on an item will open it up in the image
viewer.
To be able to use your digital camera
with Digikam, connect the camera to your
computer, switch the camera to the
image display mode and turn it on. If your
camera is detected as a mass storage
device (ex. sda1) a "New Medium Found"
window will be displayed on your desktop
along with an icon. If this does not
happen when you plug your camera in
and turn it on then you will need to setup
the camera model and port using the
setup interface. Try and see if Digikam
can auto-detect the camera; if not, you can set the camera model and port manually.

Digikam uses a folder on your file
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and displayed. You can then select the images and download or delete them from
the camera. Downloading can be done by using the menu/toolbar buttons or by
dragging and dropping them onto an album folder or any other folder that you
choose.
Digital cameras nowadays store images on either a CompactFlash card, SD card, or
SmartMedia card. The camera internally makes sub folders in these storage media
which it uses to save the images. Digikam displays these internal folder trees and
also provides a global virtual folder which shows all the images available in the
camera.
Once you have the camera setup, go
to the "Cameras" menu in the main
interface and you will see the camera
listed in the menu (Note: You can
choose any title you like for the
camera in the setup and this title will
be used in the "Cameras" menu). If
you have more than one camera, you
can add them throughout the setup
interface.

When you open the camera interface for the first time the folders are hidden and the
contents of the global virtual folder are shown (i.e. all the pictures in the camera).
You can choose to see the actual folders on the camera by unselecting "Hide
Folders" in the "View" menu. This will show the folders on the camera, the topmost
folder being the global virtual folder. Clicking on a folder will show the contents of the
folder in the thumbnailview.

Clicking on the camera item in the
menu will pop up a new Camera
Interface and this will connect to the
camera, and thumbnails (if supported
by the camera) will be downloaded
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showFoto Image Viewer
The showFoto image viewer is a
powerful tool for viewing, and
organizing graphic image files. To start
this application perform:
Main Menu -> Multimedia -> Graphics >showFoto

image and it will be displayed in full. You can also navigate to the next/previous
image as well as go to full-screen viewing. The Zoom function can be used to zoom
in or out of the image currently being displayed. Click on the Folders button at the
top of the screen to go back to the thumbnail view. A preview of the image will be
displayed in the preview area if you just select the thumbnail.
One useful feature of showFoto is the slide show. After a folder has been opened
(File > Open folder), selecting View > Slide Show will start a full screen slide show of
the images in that folder.
Image Manipulation
You can also manipulate the images under showFoto. Some supported functions
include rotation, flipping, resizing, and Blowup. To access these functions select
"Transform" from the menu bar at the top. Additional tools for working on your
graphics files can be found under the Fix menu.

Convert Format
View

The Save As function of showFoto allows you to convert your image files from one
format to another. Some of the 14 supported formats are:

The simplest way to view an image is
to double-click on the name of the

Portable Network Graphics (PNG)
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Joint Photographic Experts Group
(JPEG, JPG)
Tag Image File Format (TIFF)
TARGA format (TGA)
To use the Convert function, select an
image first and then from the top menu
bar, select,

Exercises
Use showFoto for the following:
View the images in the following folder: usr/share/backgrounds/images
View a slide show of the images in the folder above.
Copy one of the images from the above folder into your home directory and scale it
down to 25% of its original size and save it.

File -> Save As
and choose whichever format you
would like to save to from the drop
down list.

Help
showFoto has many other useful
features. The online help guide
should be consulted for more details
on how to use showFoto.
showFoto Handbook
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Linux Media Player Round Up
Part 4

Mpg123

Welcome to part 4 of our media player
roundup. Today we'll be covering a
couple of interesting players that most
older Linux users may remember, and
most new users may not even know
exists. We will also be covering
players that don't typically fit what
would be considered the norm for a
media player, but which could provide
you with quite a wide range of possible
applications for daily use. I once again
want to thank everyone for their
feedback. It's been educational to me
(hey, even I don't know everything)
and a number of the suggestions have
been passed along in one form or
another to you, the reader.

Mpg123 is a console based
player. It's really quite a simple
player overall. Play list support
is non-existent, as is any form
of music management. But
that's not a problem. That's
because mpg123 is a console
based music player. As such,
you would create your own play
list via a text file and then let
mpg123 read from that instead.
For those of you who like
minimalist media players, this is
it. It can't find directory trees full
of music, but it can browse a
single directory, and by using a
wildcard, can play all of the files in that directory for you. That might get a bit tedious,
but that's also not a problem. While mpg123 was originally the second mp3 player
ever created for Unix (MaPlay was the first), it's simple, yet efficient core decoding
engine made it a huge hit amongst Unix users, and then Linux users later on.

So, without further delay, let's dive in
and see what up on our platter for
today!
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As graphical media players came into existence and eventually widespread use,
mpg123 took on a different role. It became the mp3 engine for a lot of popular
graphical media players, most notably, XMMS and Winamp. As time went on, focus
began to shift away from mpg123 to newer, more advanced mp3 decoder engines.
During this time, mpg123 languished, with development being spotty and bugs left
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unfixed for long periods of time.
Because of this and other issues, in
1999, Joe Drew created a fork of
mpg123 named "Mpg321", which was
destined to pick up where its parent
left off and continue to develop this
versatile media player.
Then in 2002, all development on both
mpg123 and mpg321 stopped and the
two players fell to the side as has-been
media players. Mpg321 was eventually
completely abandoned in favor of
newer mp3 engines Despite the
abandonment of mpg123 by its
developers, the old guard would not let
it die. While no active development
was undertaken during this time,
developers at Gentoo, Debian,
Freebsd and other distributions all took
it upon themselves to create extensive
patch sets to fix dozens of bugs and
security holes found in the software
over the years, thus keeping the
software alive through that time. Then,
in 2006, new developers took up the
project and picked up where the old

38 :: PCLOS Magazine

developers had left off, even releasing an updated version (version 0.66) in June of
this year.
What is the uniqueness of mpg123 I've been talking about? Mpg123 can be used as
a media player engine. As mentioned above, it's already used by several different
open and closed source projects out there and can be easily used to build your own
media solution. For example, if you wanted to build your own custom jukebox,
mpg123 is a perfect backend for whatever you want to create, and you can use
either the core engine, the plug-in version of it, or the entire application. It's very
versatile that way and very light-weight at only 206k for the entire package. It also
supports audio streaming via the web, and it can export mp3's as several different
formats, including wav, Sun audio, and audio cd CDR format. This only touches on
all that it can do. Check out the man file for more information.
Mpg123 is available via most distributions as a pre-installed default application.

Muine
Muine is an audio player written
and designed specifically for the
Gnome desktop environment. It's
capable of being used on Solaris,
Linux, BSD, Unix and any other
Unix derivatives. Unlike most
media players, it's written in C#
using Mono and GTK#, an
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unusual feature indeed given that most
players are written in C, C++ or
Assembly.
While it may be written and designed
differently than most media players, it
strives to keep things simple while still
providing you with a fair number of
features. In most cases you either
have simplicity, or you have features.
You rarely have both. Muine does a
fair job of trying to balance things
between those two and provide you
both. By default, Muine supports Ogg,
Flac and MP3 via GStreamer. With its
simplistic plugin system, adding or
changing format support on your
player is very easy.

for many languages to name a few distinguishing features. Playback is good, and
getting started is easy. The playlist is also quite good. While the above picture
doesn't give a true example of this, it does show the basics. That screenshot isn't
mine because I can't seem to get good screenshots under Gnome for some reason.
But I did find this one above on the Internet and added it here so you could see just
some of what's in there.
It gagged a little bit trying to handle my 2500+ song collection, so it's possible that
larger collections may severely lag the player. Plugin support for things like iPods
and other media players was non-existent, at least that I could find. But I suspect
with the focus on balancing simplicity with features, that was tossed aside. This could
also be due to something I saw quoted on Freshmeat that says the developers
designed it to be simply a music player and not a music management system like
other players.
For more information, check out the muine player homepage.

Music Player Daemon
It supports automatic album art
fetching for your music albums,
complete ID3v2 support, and support
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There's not a lot to be said about the Music Player Daemon. As its name says, it's
designed to be a daemon, a miniature server of sorts with the goal of creating
headless media systems. This would be a perfect little program to use in a Linux
powered media device, such as a jukebox, a home theater system, or more. It's
certainly not for the faint of heart, nor the average user, as you have to create your
own frontend software that will interface with the daemon.
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If you're adventurous enough to try
and build your own media device using
this, then you'll be happy to know that
it contains support for a wide range of
media formats, including Ogg Vorbis,
Wav, FLAC, OggFLAC, MP2-4, MOD
and more. It can be remotely
controlled over a network and has
support for playing FLAC, OggFLAC,
MP3 and Ogg Vorbis streams via
HTTP. It also has quite an extensive
list of other supported features,
including ID3v1 and v2, native support
for different audio systems such as
ALSA and PulseAudio, and can run on
an impressive list of different operating
systems, including Linux, Freebsd,
MacOSX, HP-UX and many more.
It can also be used as a console
based desktop media player if you so
choose to use it that way, especially if
you're in and out of Xwindows quite a
bit. Hence why it's included here. For
the hard core Linux Audiophile, this is
the perfect tool to create a "roll your
own" media player of your own unique
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and personal design. Of course, if you don't want to create your own frontend for
MPD, there's a wide range of pre-existing projects that are designed to directly
interface with MPD. Some of those include graphical clients like GMPC, KMP and
Pygmy, or console based clients such as mpc, ncmpc, or even web based clients
such as phpMp2, Pitchfork and mpdDS. As you can see by the wide variety of ways
in which you can interface with it, it's very flexible.
Music Player Daemon is available in, or for, nearly any and every type of OS out
there that I'm aware of, except Windows. I haven't seen anything that says it'll run on
the Windows platform. But anything else is pretty much fair game. For more
information check out the MPD webpage.

MusicIP Mixer
If you're into creating detailed playlists and meticulous information about each of
your songs, you'll love MusicIP Mixer. It's much more than the name implies. It also
doesn't matter what OS you're running. MusicIP Mixer is available for Linux,
Windows and MacOS. The Windows version is shown above, however, the layout
remains the same across all versions.
Consistency is a good thing, but that's not what makes this program great. It's able to
create some amazingly detailed playlists for you, including cover art, detailed genre,
artist and album info, and much more, and all of this is displayed before you in the
four basic windows you see above at the center and right. It's ability to handle large
music collections is very impressive. While it takes a considerable amount of time for
initial cataloging of larger collections of music, once it's done, you'll never have to do
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it again with your collection. You'll still
need to let the software catalog all new
music you add to your collection over
time, but again, it only needs to do it
once. If you keep your music in a
given folder, you may never have to
add anything to the library ever again
as the monitoring feature will keep
track of what's on your drive and
update your collection accordingly.
It does all this cataloging through what
it calls its "MusicDNS acoustic
fingerprinting" which is a fancy way of
saying that it essentially listens to all
your music and comes up with the best
possible information about each song
that it can. I had some rather obscure
artists in my collection and through
simple analysis using this system, it
found even them. It even found
information on a rare song by T Texas
Tyler I had which I've never seen any
other player with album and Internet
media database support EVER get
before. This is the first one so far that
I'm aware of. So to say I'm impressed
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by this is an understatement.
Media support in general seemed pretty good. I couldn't find a list of all of what was
supported, but it found all my mp3 and ogg files ok. I couldn't see if it found the other
formats, but it did find those two. While the system is very good overall, there are
some downsides to it. For one, it's not an open source project, so if you're paranoid
about software that's not open source, you'll want to take note of that. Also, some
parts of the software are free, some are not. The basic service itself and basic
MusicDNS system are all free, but any of the extended services you may want to
work with will cost you some money.
In general, if you're fanatical about your playlists, and other data surrounding your
music, it's a good program, but other than that, there's really nothing notable enough
about it to set it apart from other media players. There's supposedly support for Tivo
and a wide range of other media devices, but nothing that would make me run out
and pay the extra money to get that support. Also, the non-open source nature of the
software is a big show stopper for many fans of OSS software. For more information
on MusicIP Mixer, check out their website.

Summary
Well, that's it for part 4. In part 5 we'll be covering several more audio player
applications as well as one that's not quite what you'd expect. For those who have
sent in information about media players I've missed so far (ones that would have
alphabetically come prior to today's), I've added those to the review queue and will
add them into the roundup somewhere in the next couple of weeks. Till then, stay
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tuned! We've got some of the best
media players in the entire Linux and
OSS world coming up!

Editors Note: PCLOS prefers that you
get packages from the repositories
and not individual application
homepages.
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Well Well Well
My Mother has Vista and my father
has XP

Now all the information is starting to gel
If I don't learn my lesson I'm going
straight to…

My brother has a Mac says “It's good
enough for me.”

Well I logged into the forum to have a
little chat

I'll only use a Linux and it better be
PCL

Read the testimonials what do you
think of that

And if you don't get one you're going
straight to…

Everyone was happy with PCL

Well I went to the forum to learn a
thing or two
Everyone said “We'll tell you what to do
Click on your partitions and all will be
swell

He'll probably tip his hat and say “Send
me a buck or two.

And if you don't mount them you're
going straight to…”

Just put it in an envelope and stick it in
the mail

Right then and there I made up my
mind
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It always will be free, you can't buy it at
Dell
Just make sure your System is a PCL

Now none of those users will go
straight to…
Well I haven't met Tex so I say “Howdy
do”

Well I hung around the forum
everyone was oh so kind

When you get a 'puter go Linux all the
way

And if you don't do that you're going
straight to…”
Well I've finished with my story but
there's a lot more to say
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by Papawoob

Just thought I would try and bring
everyone a list of currently active
PCLinuxOS based distros. If I have
missed any, I apologize. If anyone
knows of any others that are being
actively developed please drop me a
note at the Magazine website or at
Papawoob@pclosmag.com.

customize the distribution, and the inclusion of two popular desktop environments the flexible KDE and the lightweight Xfce.

Karoshi
Karoshi is a free and open source school server operating system based on
PCLinuxOS. Karoshi provides a simple graphical interface that allows for quick
installation, setup and maintenance of a network.

Ruby on Rails
CAElinux
CAElinux is based on PCLinuxOS and
is designed for computer-aided
engineering. Based on the opensource CAE softwares Salomé &
Code_Aster, you can load STEP /
IGES geometry in Salomé and start
partitioning and meshing your problem
in just 5 minutes.

Rails Live CD is a specialist distribution providing a pre-configured and fully
operating Ruby on Rails development environment on a bootable CD. The
distribution is derived from PCLinuxOS.

SAM Linux Desktop
SAM Linux Desktop, a live and installation CD based on PCLinuxOS, is an easy-touse, fast and clean XFCE Linux desktop for home users. The distribution is
enhanced by several popular non-free applications, such as Macromedia Flash
Plugin, Java and RealPlayer.

Granular Linux
Granular Linux is an easy-to-use,
desktop Linux distribution based on
PCLinuxOS. Its main features are a
carefully selected set of applications
for common tasks, the ability to
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VideoLinux
VideoLinux is a PCLinuxOS-based distribution with focus on DVD backups, video
encoding and transcoding, DVD authoring, format conversion and pretty much
anything else you want to do with video.
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TinyMe
TinyMe 2008.0 “Final” has been
released! TinyMe is a PCLinuxOSbased distribution, which is targeted at
older computers and people who want
a very light and fast desktop
environment. Although TinyMe comes
as a small, 200MB ISO, it provides
tools for most all of your everyday
wants and needs.

PCFluxboxOS
PCFluxboxOS is a series of remasters
of PCLinuxOS catering for different
end-user needs. All the following
remasters are installable live-CDs and
all come with the i586 'Legacy' Kernel
2.6.18.8 for increased compatibility
with older hardware. Newer kernels
can be installed via Synaptic.

TinyFlux - Version 1.0
PCFluxboxOS 2008 is currently under
development and release should tie in
with the release of PCLinuxOS 2008.
The aim for the next release will be to
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create a truly modular operating system using metapackages to enable users to
quickly and easily add groups of applications, all fully configured for maximum
performance with your Fluxbox desktop. See TinyFluxdownloads page for full details.

MidiFlux – 0.6b
A large selection of applications in a relatively small ISO 340MB in size.

Keldix Linux
Keldix is a Linux distribution primarily for the Small business Office and Home Office
(SOHO) market. Keldix is a live-DVD built on PCLinuxOS.

PCLOS Gnome
All new bootsplash, backgrounds, and really nice features, upgraded to a great
looking operating system, the best out-of-the-box look and user experience possible!

Business Edition Linux (BEL)
BEL or Business Edition Linux is a business implementation of PCLinuxOS 2007.
Our goal is to provide solutions for small business needs using one of the easiest to
use Linux Distributions available.

MythTVOS
MythTVOS 2008 is based on MiniMe 2008 and has MythTV and all plugins installed
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and (pre)configured. Just boot from
the liveCD, select your TV / SAT /
CABLE card and scan for channels…

decoration, localizations, preferred applications and supporting libraries to fully trick
out your desktop. In addition, you can remaster your own custom version of
PCLinuxOS. Have fun! You can find the .iso image under the Downloads button at:
http://www.pclinuxos.com/index.php?option=com_frontpage&Itemid=1

EeePCLinuxOS
EeePCLinuxOS is a PCLinuxOS
remaster specifically for the EeePC.

PCLinux Educator
A new name and a new, initial, new
way of releasing. EduLos will now be
called PCLinux Educator and will in
first instance be distributed as a
'meta'package. This means that you
can just use your vanilla PCLinuxOS
setup and in Synaptic select one
package that will immediately install all
softwares that we think are useful as a
primary student, a secondary student
or an educator.

MiniMe
This is a minimal LiveCD that is
bootable, plus it can be installed. Add
in your own background, window
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Linux EduCD
LinuxEduCD is education-scientist version of livecd type. It can be installed on hard
drive but it is not a must. System is maximally simple because for learning purposes
in schools. It contains education, graphical, business and multimedia packets.

DFPE
Pre-installed packages for everything concerning the managing and editing of digital
images. These are in almost all cases standard PCLOS packages out of the official
repositories. In only one case, a package has been upgraded to a newer version and
the upgraded packages have been provided upstream to the PCLOS development
team.

SaxenOS 2008
SaxenOS is a full fledged Linux office desktop and based on PCLinuxOS. SaxenOS
2008 isn't as lightweight as the former versions. The full OpenOffice package was
added to the speedy XFCE desktop. Also, multimedia apps and games were cut in
favour of productivity.
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Bugnux
Bugnux is a complete Linux
(Mandriva) distribution that runs from a
single bootable CD and runs entirely in
RAM. Bugnux contains an extensive
set of Open Source software testing
tools that can be used for functional
and performance testing. Standalone
tools to test GUI applications and
Mozilla Firefox extensions pre-installed
to aid in web application testing have
been packaged. This virtually can turn
any PC into black-box testing device
without having to install any software.
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